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1 S7 for Windows® Basics 

To work with S7 for Windows® basic skills are necessary.  

1.1 Opening the S7 for Windows® Software 

During the installation of S7 for Windows® an icon has been inserted. 
Double click the icon “S7 for Windows®” to start the programming 
system. 

 

Several “tabs” may be displayed at the left as well as at the button of 
the S7 for Windows® window. The “Tabs” displayed depend on the 
selected windows in the “View” menu. 
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We recommend the following settings for easier use of S7 for 
Windows®. 

1. Close all unnecessary windows. 

Open the “View” menu and select the “Offline tree” and “Online tree”. 
Deselect all other views. 

 

 

The “Offline tree” is used to select the “S7 Project” that you want 
to work with. The S7 Project contains the files necessary for a S7 PLC 
program. Later, how to generate a S7 Project will be explained. An S7 
Project is always required to work with a S7 PLC program executed on 
a PLC. 

The “Online tree” is used to select the PLC to be connected with. 
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2. Using the “Auto Hide” functions. 

It is recommended that you use the “Auto Hide” icon to lock the tab at 
the outside border of S7 for Windows®. By bringing the mouse pointer 
to the tab, the window will open automatically. 

             
 

Use the “Auto Hide” icon to close the “Offline tree” and the “Online tree”. 

 
 

3. Operator Interface mode. 

Version 6.x of S7 for Windows® has a new concept for opening and 
closing windows in the workplace. 

You can use the “Auto Hide” icon to lock the tab at the outside border of 
the workplace. By moving the mouse pointer to the tab, the window will 
open automatically. As soon as the mouse pointer leaves the 
automatically opened window, the window is closed. 

If you click at tab the opened window will stay open until it is closed. 
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Classic Operator Interface 

If the “Classic operator interface” mode is selected, the “Tool Bar” is 
extended and the open windows will stay open until they are closed. 

To select the previously described mode, click “Classic operator 
interface” in the “Window” menu. 

 

1.2 S7 for Windows® Basic Window (Classic Operator 
interface)     

 

 

In “Classic operator interface” mode the “PC Block List” window is open 
and fills the whole workplace. 
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Title Bar 

 

The title bar displays S7 for Windows®, and, if an additional Window is 
open in the workplace, the name of the open window is also displayed. 
The Icons are “Windows” specific.  

 

Open Control menu 

This icon opens the Control menu that contains the commands to 
Restore, Move, Size, Minimize, Maximize, or Close the open Window. 
The Keyboard shortcut is Alt + Spacebar. 

 

Minimizing the open window to an icon 

Clicking the button at the right side of the S7 for Windows® title 
reduces the open window to the size of an icon (same function as the 
Minimize command from the Control menu). 

 

Maximizing the open window 

Clicking the Maximize button in the upper right corner of S7 for 
Windows® will enlarge the window to its maximum size (same 
function as the Maximize command from the Control menu).  
 

Restoring an enlarged window to its previous size  

Clicking the Restore button in the upper right corner of S7 for 
Windows® will restore an enlarged window to its previous size (same 
function as the Restore command from the Control menu). 

 

Closing S7 for Windows  

Clicking the Close button in the upper right corner of S7 for 
Windows® will terminate S5 for Windows (same function as the 
Close command from the Control menu). 

Menu Bar 

 
The menu bar lists the available menus. The menus contain the 
available commands of S7 for Windows®. The menus in the menu bar 
change depending on the S7 for Windows® application windows 
opened. You can open a menu by clicking the name of the menu or by 
pressing the ALT key and then the first Letter of the menu name.  
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Open Control menu 

This icon opens the Control menu that contains the commands to 
Restore, Move, Size, Minimize, Maximize, or Close the Window 
opened (active) in the workplace.  

Tool Bar I – Classic Operator Interface 

 

The tool bar provides instant access to frequently used S7 for 
Windows® commands. Click an icon with the mouse and the command 
is executed. You can reach these functions with the keyboard via the 
window menu and/or the function keys. 

This tool bar is the same for all S7 for Windows® application windows 
(Classic operator interface mode). 
 

 

Open next Window 
This icon allows you to switch rapidly between open windows with 
a mouse click. The keyboard shortcut Ctrl+F6 provides the same 
function. 

 

PC (Personal Computer) Block List 
This index lists all the blocks with the date and time it was created 
or changed and a comment. One or more blocks may be selected 
for further manipulation. 

 

PLC Block List 
This index lists all the blocks stored in the PLC. One or more 
blocks may be selected for further manipulation in the same way it 
is handled in the windows file manager. 

 

EPROM / EEPROM / Flash EPROM Burner 
This icon opens a menu to control EPROM / EEPROM / Flash 
EPROM burning. It is only active when the EPROM burner option 
has been purchased. 

 

Cross Reference Display 
A click on this icon lists the appearance of operands, as a symbol 
or absolute, throughout the whole program. This function may be 
called from any window.  
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Block Edit 
The block selected in the block listing will be displayed in the block 
editor and is ready for any changes. The keyboard shortcut F10 
provides the same function. 

 

Symbolic Table Editor 
With this easy to use integrated editor you can write, cut, copy and 
paste text to create and modify the symbol table. The symbol table 
may be tested for multiple uses of addresses or symbols. The 
symbol table can also be sorted by addresses or symbols.  

 

PLC Error Display (I-Stack, B-Stack, Diagnostic Buffer) 
This icon enables you to view the program interrupt information 
stored in the PLC (I-Stack, B-Stack, Diagnostic Buffer). The 
information is displayed in real language with the faulty portion of 
the program. 

 

On-line PLC Status 
The status of flags, inputs, outputs, timers, counters, comparators, 
data words, and peripheral words are displayed and can be 
modified. 

 

Preferences 
This icon opens dialog boxes to customize the appearance of S7 
for Windows®. The settings for the serial port, the editors, the 
indexes, the display font and other (miscellaneous) settings are 
saved and are reloaded whenever a new PLC project is opened. 

 

PLC Block (Program) Compare 
S7 for Windows® offers a powerful PLC Program (Block 
Compare). The command Compare opens dialog boxes to select 
PLC Program files to compare (online and offline). 

 

S7 Hardware configuration  
This icon opens a window to setup and change the Hardware 
configuration of the S7 PLC. 

 

Dynamic PLC Block Display 
Enables fast switching between open PLC status windows. 

 

Closing Open Windows 
The S7 for Windows® active window is closed by clicking this 
icon. The keyboard shortcut Ctrl+F4 provides the same function. 
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Help Function 
An integrated, subject related help file with an index and a list of 
keyboard shortcuts for easy operation is available. The keyboard 
shortcut F1 provides the same function. 

 

Tool bar II   (PLC Block List) 

 
 

The tool bar II provides instant access to frequently used PC block list 
commands. Click an icon with the mouse and the command is 
executed. With the keyboard you can reach these functions via the file 
menu and the Block menu. 
 

 

Create new PLC Block 
A dialog box to establish the name of the new block is opened. 
After entering the new Block, the Block Editor window is opened 
and ready for creating a new Block. 

 

Edit Block 
The block selected in the block listing will be displayed in the block 
editor and is ready for any changes. The keyboard shortcut F10 
provides the same function. 

 

Print Block 
The marked block is printed. The keyboard shortcut Alt+B, R 
provides the same function. 

 

Transfer Block to PLC 
The marked blocks are transferred to the PLC. The keyboard 
shortcut Alt+B, T provides the same function. 

 

PLC Block Compare 
The marked Block is compared with the Block in the (online and 
offline compare). 

 

Cut Block 
The marked blocks are transferred to a temporary buffer and are 
removed from the Block List. The keyboard shortcut Ctrl+X or 
Shift+Backspace provides the same function. 
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Copy Block 
The marked blocks are transferred to a temporary buffer and 
remain in the Block List. The keyboard shortcut Ctrl+C or 
Ctrl+Insert provides the same function. 

 

 

Paste Block 
The blocks currently in the temporary buffer are transferred to the 
PC block list. The blocks remain in the temporary buffer. The 
keyboard shortcut Ctrl+V or Shift+Insert provides the same 
function. 

Workplace Column Title Bar 

 

Clicking the title of a column will sort the PC Block List information in an 
ascending order. Clicking the title again will sort the information in a 
descending order. 

The column width can be adjusted by dragging the column border with 
the mouse. 

Workplace 

All the blocks of an open PLC program file are listed in the PC block 
List. Additional application windows fill out the workplace. 

Status Bar 

 

The status bar may displays additional information on the open window 
and executed tasks. 
 

 
 

 

Note: 

The right mouse button may be used within the Workplace.  

If the right mouse button is clicked, a menu with the most important 
commands is opened. 
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1.3 Generating a S7 Project 

A new S7 Project can only be generated in an existing Folder.  

 

It is not recommended that you generate a new project directly in the 
“My Documents” folder. You can name a new folder and put it in the 
“My Documents” folder, for instance “S7_Training”. 

Generate a new “S7 Project” folder 

 
 

 

 

Note: 
Windows with “Online – information” have a light green background. 

Note: 
Windows with “Offline – information” have a light yellow background. 

Note: 

To “debug” a PLC program located in the PLC, you have to have the PLC 
program located in a S7 Project. This could be the original project with 
comments and symbols (preferable).  

If the original project is not available you must download the PLC program 
into a newly generated S7 Project. 
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Commands to open a new project 

S7 for Windows® provides the possibility to generate S7 projects in the 
same format than the SIEMENS® STEP® 7 projects.  

This way import and export functions are not required with S7 for 
Windows®. 

The following t explains the handling of a “New STEP® 7 project”. 

• Click “New STEP® 7 project” in the File / New Menu. 

 

• Select the “Path” in the “Create new STEP®7 project” dialog 
box and click “New”. 
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• Type the “Project Name” in the “Create new STEP®7 project” 
dialog box and confirm with “OK”. 

 

• If you want to transfer a PLC program from a S7 300 PLC click 
the “New S7-300® station…” button. If the PLC you want to 
work with is a S7 400 PLC click the “New S7-400® station…” 
button and confirm with “OK”. 

The S7 project with its name “PROJECT_1” is listed in the “Offline – 
Tree”.  

 

If the “Offline” tab is not shown, use the command “Offline tree” from 
the “File” menu. 
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It is recommended that you use the “Auto Hide” icon to lock the tab at 
the outside border of S7 for Windows®. By moving the mouse pointer to 
the tab the window will open automatically. 

 
 

 

1.4 Selecting the English Mnemonics 

In the US, PLC programs usually use English Mnemonics. 

 

Note: 

A “Project” is required to make a PLC user program. You also must have 
an open project to transfer and save an existing program from a PLC for 
backup purposes. 
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The selection changes the mnemonics of the instructions (key words), 
the operands in the logic and the symbolic table. The selection will not 
change the language of the program (menu commands, symbols, 
comments, etc.). 

 

The mnemonics to identify Bit-Memory, Timers, Counters, Inputs, 
Outputs, and the instruction set used for Statement List (STL) 
programming are identified with their English (International mnemonics) 
syntax. 

Examples: 

Input I Timer T OR O 
Output Q Counter C Count Down CD 
Memory M AND A Count Up CU 
 

1.5 S7 for Windows® Basic Window (Standard interface) 
 

 

Opening the S7 for Windows® Software 
 

 

During the installation of S7 for Windows® an icon has been inserted. 
Double click the icon “S7 for Windows®” to start the programming 
system. 

Note: 

If you are not familiar with S7 for Windows® we recommend that you use 
the “Classic operator interface” (see chapter 1.2). 
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S7 for Windows Basic® Window 
 

 

Title Bar 

 

The title bar displays S7 for Windows®, and, if an additional Window is 
open in the workplace, the name of the open window is also displayed. 
The Icons are “Windows” specific.  
 

Open Control menu 

This icon opens the Control menu that contains the commands to 
Restore, Move, Size, Minimize, Maximize, or Close the open Window. 
The Keyboard shortcut is Alt + Spacebar. 

 
 

Minimizing the open window to an icon 

Clicking the button at the right side of the S7 for Windows® title 
reduces the open window to the size of an icon (same function as the 
Minimize command from the Control menu). 

 
 

Maximizing the open window 

Clicking the Maximize button in the upper right corner of S7 for 
Windows® will enlarge the window to its maximum size (same 
function as the Maximize command from the Control menu).  

 

Restoring an enlarged window to its previous size  

Clicking the Restore button in the upper right corner of S7 for 
Windows® will restore an enlarged window to its previous size (same 
function as the Restore command from the Control menu). 
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Closing S7 for Windows  

Clicking the Close button in the upper right corner of S7 for 
Windows® will terminate S7 for Windows® (same function as the 
Close command from the Control menu). 

 

Menu Bar 

 

The menu bar contains a list of menus. You can open a menu by 
clicking the name of the menu or by pressing the ALT key and then the 
first Letter of the menu name. 

Tool Bar – Standard Operator Interface 

 

The tool bar provides instant access to frequently used  
S7 for Windows® commands. This tool bar is the same for all  
S7 for Windows® application windows. Click an icon with the mouse 
and the command is executed. You can reach these functions with the 
keyboard via the window menu and/or the function keys.  

 

CPU Function (I-Stack, B-Stack, Diagnostic Buffer) 
This icon enables you to view the program interrupt information 
stored in the PLC (I-Stack, B-Stack, Diagnostic Buffer). The 
information is displayed in real language with the faulty portion 
of the program. 

 

PLC Block (Program) Compare 
S7 for Windows® offers a powerful PLC Program (Block 
Compare). The command Compare opens dialog boxes to 
select PLC Program files to compare (online and offline). 

 

S7 Hardware configuration  
This icon opens a window to setup and change the Hardware 
configuration of the S7 PLC. 

 

EPROM / EEPROM / Flash EPROM Burner 
This icon opens a menu to control EPROM / EEPROM / Flash 
EPROM burning. It is only active when the EPROM burner 
option has been purchased. 
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Cross Reference Display 
A click on this icon lists the appearance of operands as a 
symbol or absolute throughout the whole program. This function 
may be called from any window.  

 

Dynamic PLC Block Display 
Enables fast switching between open PLC status windows. 

 

Block Edit 
The block selected in the block listing will be displayed in the 
block editor and is ready for any changes.  

 

Symbolic Table Editor 
With this easy to use integrated editor you can write, cut, copy 
and paste text to create and modify the symbol table. The 
symbol table may be tested for multiple uses of addresses or 
symbols. The symbol table can also be sorted by addresses or 
symbols. The keyboard shortcut F6 provides the same function. 

 

On-line PLC Status 
The status of flags, inputs, outputs, timers, counters, 
comparators, data words, and peripheral words are displayed 
and can be modified. 

 

Preferences 
This icon opens dialog boxes to customize the appearance of 
S7 for Windows®. The settings for the serial port, the editors, 
the indexes, the display font and other (miscellaneous) settings 
are saved and are reloaded whenever a new PLC project is 
opened. 

 

Closing Open Windows 
The S7 for Windows® active window is closed by clicking this 
icon. The keyboard Ctrl+F4 provides the same function. 

 

Help Function 
An integrated subject related help file with an index and a list of 
keyboard shortcuts for easy operation is available. The 
keyboard shortcut F1 provides the same function. 

 

Workplace 

Additional application windows fill out the workplace. 
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Status Bar 

 

The status bar may displays additional information on the open window 
and executed tasks. 
 

 

1.6 File (File Menu - PC Block List) 

 

Note: 

The right mouse button may be used within the Workplace.  

If the right mouse button is clicked, a menu with the most important 
commands is opened. 
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File (File Menu - PC Block List) 

The commands in the File Menu control the opening and saving of 
projects (files). Your personnel preference settings as well as the 
printing and documentation layouts are also controlled by the 
commands from this menu. Basic online debug functions are also 
available. 

New (New Project) 
The New command is used to create a new project. An additional menu 
is opened to select the type of project (see Chapter 1.3 Generating a  
S7 Project). 

Save Online Blocks 

 

The PLC Blocks in the connected online PLC can be saved in an 
archive file (compressed). A dialog box is opened where you can select 
the Archive Name and the path to save the archived PLC program. 
This command is used to backup PLC programs and save the different 
versions (Backup History).  

 

Restore Online Blocks 

 

The archived PLC Programs saved in the PC (different versions – 
backup History) are listed. The marked archived PLC Program can be 
transferred to the connected online PLC. This program will replace PLC 
program inside the PLC. 
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Restore Online Blocks 

 
 

Transfer Project to the PLC 

 

The PLC Program marked in the “Offline Tree” is transferred to the 
connected online PLC. 

 

Prior to overwriting a Block a warning is displayed to allow or cancel the 
overwriting. 
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Search For 

 

A dialog box is opened providing the tools to search for an operand or 
text within a PLC Block or within the whole PLC program. This feature 
works only with the offline S7 project. 

 

The result is shown in the “Search result” window. 

 

Double clicking a line or using the right mouse button will open the 
editor window displaying the Block and Segment of the selected 
operand. 
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Replace 

 

A dialog box is opened providing the tools to replace an operand or text 
within a PLC Block or within the whole PLC program. This feature works 
only with the offline S7 project. 

 

If “Replace with confirm” is marked a field is open to allow or not each 
replacement or cancel the replacement completely. 

 
 

Compress PLC Memory 

 

Deleting blocks in the PLC does not remove these blocks from the PLC 
memory. The deleted blocks still occupy space in the memory. If blocks 
with the same name are transferred to the PLC, the old block remains in 
the PLC and occupies space in the PLC memory. The Compress 
command, from the PLC menu, reorganizes the PLC memory. All the 
unused blocks are deleted. After executing this command only usable 
blocks remain in the PLC memory. 
The compress function does not work in the RUN mode. 
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Clear / Reset PLC 

 

Overall Reset; Erasing the Program Memory and Resetting the CPU 

Before downloading a new program to the S7 programmable controller 
(PLC) a memory reset on the CPU should be performed to ensure that 
no "old" blocks and information are still in the CPU. 

Overall Reset deletes the following: 
A memory reset clears the following data from the selected module: 

• Work memory  

• Read/write area of the load memory  
If a memory card is inserted, the module copies the contents of 
the memory card to the internal load memory following the 
memory reset. 

• System memory 

• Backup memory 
 

The S7 MPI parameters and the diagnostic buffer are not changed. 

 

Click the command “Clear / Reset PLC” in the File menu. 

To ensure that the command “Clear / Reset PLC” is not accidentally 
executed a warning is displayed. Confirm the warning. 

 

If the CPU is not in the Stop mode a message is displayed and the 
command “Clear / Reset PLC” will not be executed. 

 



 Page  1-24 S7 for Windows® Basics Chapter 1  
      

S7 for Windows®   Training  TTI   Trans Tech International©   2009 
 

Copy from RAM to ROM 
This menu command copies the contents of the RAM of the active 
module to the ROM area (only modules which support this function). 

PLC State 

 

Several displays are provided to display the status of the online PLC. 

If the PLC is running only the common, the S7 Diagnostic Buffer and 
the S7 memory usage display are available. 

If the PLC is in a stop due to a fault condition, the Interrupt Stack (I-
Stack) and the Block Stack (B-Stack) will display the reasons for the 
stop condition. 

Common Information 

 

The "Module Information" property sheet contains detailed diagnostic 
and maintenance information on the module. Depending on the 
diagnostics capability of the module different information are available. 
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Interrupt Stack (I Stack) 
Clicking the “Interrupt Stack” tab opens the interrupt stack (I stack). The 
interrupt stack always refers to a priority class. First the respective 
organization block must be marked (selected) in the B stack. 

The data displayed is valid for the interrupted priority class assigned to 
the organization block (OB) selected in the block stack.  

 
 

RUN 

The PLC is in a RUN condition. Clicking the button puts 
the PLC into a RUN condition. 
 

STOP 

The PLC is in a STOP condition. Clicking the button puts the PLC into a 
STOP condition. 
 

Register (ACCU's) 

The contents of accumulators 
1, 2, 3, and 4 are displayed in 
hexadecimal form.  
 

Block and Segment 

The block and the Segment where the PLC 
program was interrupted (stop condition) is 
displayed. 
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Data Blocks 

The active data blocks (DB) are listed 
when the PLC program was interrupted, 
the data block numbers will be displayed. 

Status 

Status Word Bits: 

The bits zero to eight of 
the status word are also 
displayed and given an abbreviation for their meaning (bit 9 … 15 
unassigned). 

Assignment Bit Description 

BR 8 Binary Result 

The BR bit is used to indicate whether or 
not an error occurred during the 
execution of an SFB or SFC.  
 If an error occurred the BR bit is 0 
 If no error occurred the BR bit is 1 

CC 1, CC 0 7, 6 Condition Code 1 
Condition Code 0 

The CC1 and the CC0 bits provides 
information about the results of various 
operations: 
 Results of a math instruction 
 Results of a shift or rotate 
 instruction 
 Results of a comparison instruction 
 Results of a word logic instruction 

OV 5 Overflow 

The OV bit is set if an error occurred 
during an arithmetic function, math 
function or compare function.  
The OV bit is reset if the fault is cleared. 

OS 4 Stored Overflow 

The OS bit is set together with the OV bit 
but is not reset if the fault is eliminated.  
The bit can be reset with the Jump if 
OS=1 (JOS), the block call, or the block 
end commands. 

OR 3 Or  
(AND before OR) 

The OR bit is used during the execution 
of a logical AND instruction (A, AN, A(, 
AN(,)and NOT) prior the OR operation.  
If the RLO of the logical AND instruction 
a "1", the OR bit is set. Any other logical 
bit instruction resets the OR bit. 

STA 2 Status The STA bit stores the value of the 
addressed (referenced) bit. 
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Status Word Bits (continued) 

Assignment Bit Description 

RLO 1 
Result of Logic 
Operation 
(previous) 

The RLO bit stores the result of a logical 
operation triggered by a bit logic 
instruction or math comparing 
instructions. 

/FC 0 First Check Bit 
(negated) 

The value of the FC bit is used to control 
chained logical and compare instruction. 

 

Portion of Erroneous Block 

 
 

A list field is provided to display the portion of the PLC where the fault 
occurred. The statement where the PLC went into a STOP condition is 
displayed with a blue background. 

Block Stack (B-Stack) 
During the program execution the jump instructions enter data in the 
block stack. The block where the jump (block call) originated and the 
following locations are listed. The block stack lists all the blocks that 
that were called but had not been completely processed prior to the 
CPU going into its STOP mode. 

 

Details are displayed about the selected block (segment). Mark the 
Block that you want details on. 
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L-STACK 
The data in the L-Stack (local Temp data) can 
be displayed. Select the Block and click the “LSTACK” button. 

 

S7 Memory usage 
The used memory with its absolute addressing is displayed. A button is 
provided to compress the memory. 
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PLC Access Permission 

  

The “SETUP” command opens a dialog box to assign a password to 
access an online connected PLC. With the “Cancel” command the 
access can be permitted. Not all CPUs support this function. 
 

Memory Card File 

 
The "Memory Card file New…" and "Memory Card file Open…" 
functions can be used to save a full set of data from a project to a 
memory card along with any other data desired.  

These data can then be retrieved from the memory card for subsequent 
use. In addition, you have the option of saving the current user program 
(including the HW configuration) to the memory card. To save or 
retrieve data, the memory card can be located either in a CPU or in the 
slot of a programming device (PG) or PC. The "New…/Open… Data on 
Memory Card" functions are only available for newer CPUs. 

Preferences 

 
The Preferences command or clicking the icon opens the Preferences 
dialog box. 

The dialog box is designed as a card file with tabs to separate the 
different subjects.  

Each dialog box card offers buttons and command fields to setup the 
appearance of S7 for Windows®. 
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Block View Tab 

 
 

Mnemonics 

The language of the mnemonics you want 
to use can be set. The selection changes 
the mnemonics of the instructions (key 
words) and the operands in the logic and the symbolic table. The 
selection will not change the language of the program (menu 
commands, symbols, comments, etc.). 

English Mnemonics 

The mnemonics to identify Bit-Memory, Timers, Counters, Inputs, 
Outputs, and the instruction set used for Statement List (STL) 
programming are identified with their English (International mnemonics) 
syntax. 

Mnemonics  Mnemonics 
Name English German  Name English German 
Input I E  Counter C Z 

Output Q A  AND A U 
Memory 
(Flag) 

M M  Count 
Down 

CD ZR 

Timer T T  OR O O 
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Column Width 

S7 for Windows® can display a symbolic 
operand with up to 24 characters (without a 
hyphen). To display symbolic operands 
with their full length name, the column 
width is adjustable. It is insured, that the 
operand is correctly identified even when 
the symbolic name is truncated in the display. 

The column width is separately adjustable for the Control System 
Flowchart (CSF) and the Ladder Diagram (LAD) display. You can select 
a column width between 10 and 26 characters (including the leading 
hyphen) for the CSF display. LAD display allows a column width 
between 12 and 28 characters (including the leading hyphen). 

The number entered as the column width is the number of characters 
spaces possible to display. The width of a character space varies with 
the font selected and does not always match the width of the other 
characters. Usually the number of space characters is slightly higher 
than the number of characters possible to be displayed in a given 
column width. 

Column width example S7 for Windows® 
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Status Values 

Address 
In this column the memory addresses of the 
S7 instruction is displayed. The address 
displayed in the STL Status window online 
is the relative addresses within the PLC 
RAM area. 

RLO 
In this column the Result of a Logical 
Instruction (ROL) of the instruction in that 
specific line is displayed. 

Contents 
In this column the Status Bit or the Contents 
of counters and timers is displayed. 

ACCU1, ACCU2 
In these columns the contents of the Accumulators are displayed. The 
accumulators are 16 or 32 bit general purpose registers and are used to 
process bytes, words, and double words. 

Status Word  
In this column the contents of the Status Word is displayed. The eight 
(8) lower bits of the 16 bit Status Word Register are showing detailed 
information about the instruction. 

Address Register 1, Address Register 2 
The contents of the Address Registers are displayed in these columns.  

DB Register 1, DB Register 2 
The contents of the Data Block Registers are displayed in these 
columns.  

Indirect Address  
In this column the information about the indirect addressing in use are 
displayed. 
 

 

Note: 

The more information you want to display in the STL Status window the 
longer it takes to build up the STL Status window. All information being 
displayed has to be transferred from the PLC to the PC. 
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Display all Parameters 

 

If selected all formal operands are displayed if calling a Function Block 
(FB). 

Background Color 

The default setting is that Windows with 
“Offline – information” have a light yellow 
background. Windows with “Online – 
information” have a light green background. 

The color of the background can be changed. Clicking the 
button will open a dialog box to change the colors. 

 

Fonts Tab 
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The font can be changed. Clicking the button will open a dialog 
box to change the fonts.  

Different fonts may be assigned to various subjects for separation and a 
better reading. Also the font size and its style may be set. 

 

 

Write Protect Tab 
With S7 for Windows® you can prohibit the online access to the PLC. 
The access can be password protected. 

Print 

 

The command Print opens the dialog box Print The dialog box gives 
you the ability to select the items to be printed. 

Note: 

The font selection (done via the Presentation Fonts settings) is for the 
CRT display only. The fonts for the documentation printout are selected 
with the settings from the Font Type card of the Documentation Layout 
dialog box. 
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Print 

 
 

Block List  
If the block list button is marked, a list is printed with the information 
displayed in the PC Block List window with the names of the blocks, 
their length, date and time of the last modification, and the comments 
that will be printed out 

Symbolic Table 
If the symbolic table button is marked, the symbolic table will be printed 
out. 

Used Operands List 
The portions of the Used Operands List to be printed can be selected. 
You may mark one, several, or all operand groups to be printed in the 
used operands list. The used operands list is printed, showing the 
selected operands and where they are used (block and segment 
number) within the PLC program. 

Cross Reference List 
The portions of the Cross Reference List to be printed can be 
selected. You may mark one, several, or all operand groups to be 
printed the cross- reference list. The cross-reference list is printed 
showing the selected operands and where they are used (block and 
segment number) within the PLC program. 
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Print Settings 

 
The Print Settings command or clicking the icon opens the 
Documentation Layout dialog box. 

The dialog box is designed as a card file with tabs to separate the 
different subjects.  

 

 

Margins Tab 
Select the set margins dialog box to customize the page layout. The 
margins of the Program Text (Main Body – area where the PLC logic is 
printed) and the Footer (Header / Footer) are set independently. The 
dimensions are in centimeters (cm). 

 The measurements must be entered in centimeter (cm). 

 The margins for the header and the footer are measured relative to 
the page. 

 The margins of the main body are measured relative to the header 
and footer (inside). 
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Page Layout Margins 

  
 

The tab provides fields to customize the appearance of the page of 
documentation for the PLC program. 

You may type any text in the text fields. There are field abbreviations 
available to assist you when entering PLC program information and 
date and time information to the header and footer. Buttons are 
available to disable the footer or header. The font for the header and 
footer may also be set. 

Header / Footer Tab 

 

Main Body

Header / Footer

Header / Footer  

Top

Botton
Left Right

RightLeft

Botton

Top
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Font 
The font can be selected. Clicking the button will open a dialog 
box to change the fonts.  

The font selections made in the Fonts Type settings box, are used for 
printing only. 

Header 
The tab provides a field (you may enable / disable the header) to 
customize the appearance of the page header of documentation for the 
PLC program. You may type any text in the text field. 

Footer 
The tab provides a field (you may enable / disable the footer) to 
customize the appearance of the page footer of documentation for the 
PLC program. 

There are field abbreviations available to assist you when entering PLC 
program information and date and time information to the footer. You 
may type in addition to the abbreviations any text in the text field. 

Footer Field abbreviations 

%f File name of the PLC program without file name extension. 

%t List name (Title). 

%p Page number. 

%a Day   Printing date  

%b Month   Printing date. 

%c Year   Printing date. 

%d Day   File creation/modification date. 

%m Month   File creation/modification date. 

%y Year   File creation/modification date. 

%h Hour   File creation/modification date. 

%I Minutes   File creation/modification date. 

%s Seconds  File creation/modification date. 
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Connect to the last selected PLC 

 

The last selected PLC online connection is established again (how to 
select and establish an online PLC connection see chapter 2). 

 

Connect to the last selected PLC 

 

The PLC online connection is disabled. 
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2 S7 for Windows® Online Functions 

How to troubleshoot an On-Line connection to the PLC  

2.1 Connecting the S7 PLC with a PC 

Programming Unit
PC PLC Control

S7 for
Windows

 

The S7 PLC’s connected to the PC are listed in the “Online – Tree”.  

All possible connections are listed. To select a connection 
click the icon in front of the name. The established 
connection is displayed in bold letters. 
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If the “Online” tab is not shown, use the command “Online tree” from 
the “File” menu. 

 

It is recommended that you use the “Auto Hide” icon to lock the tab at 
the outside border of S7 for Windows®. By moving the mouse pointer to 
the tab, the window will automatically open. 

 
 

S7 SoftPLC internal 

 

On the PC executing S7 for Windows®, an S7 SoftPLC can be installed 
(optional). This software PLC could be used to control machinery. 
Inputs and outputs are handled via a bus system (Profi Bus etc.) 

Internal S7 PLC Simulation 

 

S7 for Windows® provides an internal simulation PLC. With the 
integrated simulation PLC you can test PLC programs. For testing you 
do not need additional hardware. The programs are tested directly 
within your PC. The status is displayed, you can force inputs, and you 
can display the outputs.   

The internal simulation PLC is fully compatible with the S7 CPU 416. 
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S7 IBH Link Network 

 

The IBHLink S7 is an Ethernet-converter within a 
15-pin Sub-D-housing for a connection via a switch, 
a hub or even directly to a PC with a common 
network adaptor. The protocol used is the standard 
TCP/IP protocol. In this way, the user can benefit 
from all the advantages of Ethernet, such as remote maintenance via a 
standard router or VPN-connections (Virtual Private Network). Likewise, 
a direct connection to the Internet is possible.  

S7 CP via TCP/IP; S7 CP via H1 

These connections require “Communication Processer Boards” in the 
PLC. The connections are listed because a standard Ethernet 
connection is required at the PC side. 

Communication Port (COM1) 

 

Selecting the Communications serial ports 
(COM 1 – COM 4) will open a dialog box to select the Baud Rate and 
the Protocol. USB Cables require conversion software. 
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The Simatic S7 PLC must be connected to one of the serial ports  
(COM 1 – COM 4) of your PC via a MPI Converter Cable.  

Depending on the type (manufacture) the MPI Converter Cable can 
handle Baud Rates of 1920 Baud, 38400 Baud or, 115200 Baud.  

USB Serial Port (COM4) 

 

S7 for Windows® cannot handle an USB Port 
connection directly. To use an USB connector 
cable, software must be installed to convert the 
COM port connection to an USB port. This software driver is provider 
with the USB cable. The following pictures show the correct settings of 
the USB Serial Port conversion. Double click “USB Serial Port (COM3) 
to open the dialog to set the port parameters. 
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Device Manager Settings (USB – COM conversion) 
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2.2 Transferring all PLC Blocks of a STEP® 7 Program to the 
PLC 

The PLC Blocks of a STEP® 7 Program can be directly transferred to 
the connected PLC. No conversion is necessary.  

Transferring a STEP® 7 Program to the PLC 
The following icon identifies a STEP® 7 Program. PLC 
projects (programs) created with the basic PLC 
programming package STEP® 7 from SIEMENS may 
directly be transferred to the PLC.  

Open the “Offline – Tree” and click the program name        
with the mouse button. Click the “PC block list” tab. 

 
 

The PC block list window opens. Open the context menu with a right 
click on any of the Block names. With a click on the command “Transfer 
all Blocks to the PLC” the S7 Program is transferred to the connected 
PLC. 
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If a block is currently stored in the PLC, a dialog box will open to allow 
you to overwrite the block or to abort the transfer. 

 

Activating the “Yes” button will only overwrite the PLC block mentioned 
in the dialog box. If another block is stored in the PLC, the dialog box 
will be opened again. 

2.3 Transferring a PLC Program or PLC Blocks to the PC 

To transfer Blocks from the PLC to the PC, an S7 project must be 
available in the PC to store the transferred Blocks. The project must be 
selected prior transferring Blocks to the PC. 

A single Block, several Blocks or all Blocks can be transferred via the 
serial link to the PC. The selected (marked) blocks in the PLC block list 
are transferred to the PC. This can be a single block or multiple blocks. 

 

 

Warning: 

You should only transfer blocks from the PLC to the PC if the 
selected blocks do not exist in the PC Block List.  

If a block in the PC is overwritten by a PLC block, it is possible that 
comments will be shifted. Jumps may not be valid anymore and jump 
labels may be exchanged with substitute labels (M001 etc.) and shifted. 

The names of Local Variables are changed into substituted names  
(IN1, OUT2, IN_OUT3, STAT4, TEMP5, etc. 
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Select the Project, the Hardware Station and the S7 Program to save the PLC 
Program 

 

How to generate a project and an S7 300 / 400 Hardware station, see 
chapter 1.3.  Mark the S7 Program folder. 

 

Make sure the PC Block List is empty. 
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Open the PLC Block List 

 

To transfer all PLC Blocks from the PLC to the PC, use the command 
“Transfer all blocks to PC”. Click on one of the marked Blocks with the 
right mouse button. Click “Transfer all blocks to PC”. 

 

All Blocks from the PLC are transferred to the PC and are listed in the 
“PC Block List”. 

If you want to transfer the hardware configuration as well, 
(recommended), click “OK” in the opened information box. 
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The marked Blocks are transferred to the PC and are listed in the “PC 
Block List”. 

 

If you want to transfer one or several blocks to the PC, mark these 
blocks in the PLC Block List and click on one of the marked Blocks with 
the right mouse button. Click “Transfer to PC”.  

 

Instead of using the right mouse button and the command “Transfer to 
PC” you may use the “Transfer to PC” icon. 
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3 S7 for Windows® Tools to Debug a S7 PLC Program 

Most tools to debug a S7 PLC Program can only be used if the PLC 
Program is present in the online PLC, and also saved in a S7 Project 
on the PC.  

 

3.1 Opening a S7 PLC Program saved in a “S7 Project”  

Open the “Offline – Tree” by pointing at the “Offline” tab.  

 

If the “Offline” tab is not shown, use the command “Offline tree” from 
the “File” menu. 

 

ATTENTION: 

If you don’t have the original PLC program with symbols and  
comments we recommend that you download the PLC program 
to the PC as described in chapter 2. 
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In the “Offline” window select the path and click on the icon 
in front of the project name (S7_User_Proj_US). 

The project files and other tools are shown. 

 

The project name and the S7 Program name (S7 User Prog) with its 
path, is shown. Also the Blocks are listed in the “PC Block List”.  

 

The PLC Program is now open for further use. 
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3.2 Comparing the existing Online and Offline PLC Program 
 

 

 

Select the required PLC at the “Offline – Tree” and the PLC to be 
connected to from the “Online – Tree” (see chapter 1). 

 

ATTENTION: 

If you are using the original PLC program with symbols and  
comments make sure that the program executed at the PLC 
is identical with the original PLC program you have on the PC. 

Use the “Compare Tool” to verify that the Program on the PC has the 
same code as the PLC program executed at the PLC. 
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Compare Tool 

 

Click the icon to open the Compare window. 

You may select the two locations where the files to be compared are 
located.  

 
 

When comparing a PLC Program on the PC with the Program executed 
on the PLC, only the code is relevant. Mark “Compare code only”. To 
start the comparison confirm by clicking the “Compare” button. 

 

The compare result is shown in the upper part of the compare window. 
PLC Block names written in black are identical, PLC Block names 
shown in red have differences in the code.  
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Differences in Code 

 

Clicking the Block name opens a window with the details of the 
compared Blocks. Any differences are displayed in red. 
 

 

ATTENTION: 

Comparing a PLC Program on the PC with the Program executed 
on the PLC will show (most of the time) differences in  
Data Blocks (DBxx). This is normal if the data stored in the  
Data Block is collected from the PLC. 

In any event the length of the Data Blocks must be identical. 

ATTENTION: 

Do not transfer blocks from the PLC to the PC if the selected  
blocks exist in the PC RAM.  
If a block in the PC is overwritten by a PLC block, it is possible 
that comments will be shifted and labels may not be valid anymore (labels 
are exchanged with substitute labels (M001 etc.). 
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3.3 Arranging Window in the Workplace  

Version 6.x of S7 for Windows® has a new concept to open and close 
windows in the workplace.  

You can use the “Auto Hide” icon to lock the tab at the outside border of 
the workplace and by moving the mouse pointer to the tab the window 
will open automatically. 

It is also possible to open the “PC Block List” in the workplace and start 
the “Debug Tools” from there. The “PC Block List” window stays open 
until you close “PC Block List” the window. 

This mode is preferable if you want to change between Blocks being 
displayed online and offline for modifications.  

To work in this “Classic Operator Interface” mode the S7 PLC Program 
must be opened (see chapter 3.1).  

To select the previously described mode, click “Classic operator 
interface” in the “Window” menu. 

 
 

PC Block List in “Classic Operator Interface” mode 

 



 Chapter 3 S7 for Windows® Tools to Debug a S7 PLC Program Page  3-7  
      

TTI   Trans Tech International©   2009  S7 for Windows®   Training 
 

3.4 PLC Block Status display 

To display the PLC status you must open the desired PLC Block with 
the “Editor”. You may open the Editor by double clicking the Block name 
or by marking the Block name and clicking the icon. 

 

The Block may be selected from the “PC Block List” or the “PLC Block 
List”. If you use the “PC Block List” existing symbolic comments may be 
displayed within the status display. 

 

Activating the Status 
An icon is provided to activate the status. Clicking the icon again will 
deactivate the status. 

 

Note: 

We recommend that you select the Block from the “PC Block List”. If any 
modifications are made they are saved in the PC and therefore are 
available the next time the Block is opened.  
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Status Display, Statement List (STL) Presentation 

 

Status Display, Ladder Logic (LAD) Presentation 
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Status Display, Ladder Logic (LAD) Presentation with Symbolic Table 

 

Status Display, Control System Flowchart (CSF) Presentation 
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